MGMT404
Lesson #5 - Working With Calendars
MS Project

V2007
Due Date:  Check Class Schedule/Syllabus


Objectives 

· Change the working and non-working time on Standard Calendar

· Change the working and non-working time on a Resource Calendar

· Create new base calendars

· Assign different base calendars to resources

With calendars, you can determine when resources on a project are working and when they are not working.  If you do not indicate when resources are available, you may accidentally schedule tasks when resources are not actually available. Calendars are part of determining availability of resources.

In MS Project, calendars define the working and non-working time for the project and for each resource assigned to the task.  As a change is made to a calendar, MS Project automatically reschedules all tasks affected by the change.

Using Calendars

There are two types of calendars in Project: base calendars and resource calendars.  Base calendars define the working days and working hours for a project or a set of resources.  Resource calendars define the working days and working hours for a specific resource.

The default base calendar (also known as the project calendar) is called Standard.  This standard calendar is usually set as an 8-hour day, 40-hour week, Monday through Friday, with no holidays.  However, you can modify this standard calendar, but it is not recommended.  MS Project also comes with two other base calendars: a 24-hour calendar and a night shift calendar.  You can also create your own base calendars.  You can manipulate such options as default start time and hours per day.

Note: Resource calendars are updated automatically when the base calendar assigned to the resource changes.  But changes to the default calendar options are not automatically displayed in the base calendar.

When we first set up this project, MS Project assumed the Standard calendar.  As we entered task duration, MS Project calculated the amount of work based upon 8 hours a day, 40 hours per week, Monday through Friday.  So when we entered 2 days for the task, Inventory Current Equipment, prior to any resource assignment, MS Project calculated 16 hours of work (8 hours per day), to start at 8 AM, Wednesday morning and concluding 5 PM, Thursday evening.  When we assigned resources, each resource was by default also assigned a standard calendar.  However, if the resource we assigned had a different working time, the same amount of work would have been calculated, but the actual time of duration would have changed.


Note: When you open dialog boxes that contain calendars, MS Project will also show the current day and month.  Therefore you will need to scroll to the correct month for this project/lab.

To view the standard calendar options:

1. Open MS Project. 

2. Open your project file from Lab 4 (MyLab4.XXX.mpp)

3. Save As MyLab5_XXX.mpp, where XXX are your initials. 

4. Make sure you are in Gantt chart view, Table: Entry.

5. From the Tools menu, click Options.  

6. Click the Calendar tab.  

7. The default options are displayed (Figure 1).
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Figure 1
Note: if you anticipate that your project start time will be earlier than 8 AM, you should change the calendar options and the Standard calendar before entering tasks and resources.  Otherwise, the first task will remain scheduled to start at 8 AM even if the options and base calendar are changed.

Please note the defaults for the Standard calendar.  Also note the changes you can make to the standard calendar.  The emphasis must be made that this calendar is primarily for the entire project.  Again it is best not to change these calendar settings unless absolutely necessary.

8. Click Cancel after observing.  We will not be making changes to this calendar.

Changing the Working Time

The best way to make changes to a base calendar is to change the working time. For example, let's say that Monday, October 8, 2007 is a company holiday and we need to make sure no work is scheduled on that day.

1. Click on the Project menu and select Project Information.  Note that our project is scheduled to begin on Monday, October 1 and end on Friday, November 23.  Press OK to close window.

2. From the Tools menu, select Change Working Time.  

3. Select Monday, October 8, 2007, using the scrollbar.  (Make sure you have the right year!)

4. Under Set Selected Date(s) to: click Nonworking Time.  (Figure 2).

5. Press OK.

6. Check your Project Information Statistics.  This change did not have an effect on the finish date, but overall duration of the project was shortened by one day to 38.25 days.  Why?  (Hint: critical path?)
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Figure 2
7. When you close this dialog box and check your Gantt chart, you will notice that Monday, October 8 is shaded gray in the column.

8. Just reverse; let's say that due to this holiday, we will be working on Saturday, October 13 from 8 AM to 12 PM and 1 PM to 5 PM (we have a one hour lunch break).

9. Under Tools, select Change Working time again.  

10. Click on Saturday, October 13, 2007.

11. Select Nondefault working Time. 

12. Enter the two time frames: from 8:00 AM to 12:00 PM and from 1:00 PM to 5:00 PM.  (Note: they may be automatically entered for you!  Can you guess why?)

13. Click OK.  What happened to your project completion date and overall duration? (Same completion date, but why 39.25 days?)
14. On your own: Let's say that for this entire project we will be working on Saturdays, but only from 8 AM to 12 PM (Noon).  Change all the Saturdays in October, November and December (2007) to the working times indicated below (8am to 12pm), including October 13, 2007.  How would you do this?

(Hint: To change all Saturdays, try highlighting all Saturdays by clicking on the S for Saturdays in the column header. Then change the working time. See Figure 3.  However, if you use this technique you will not change the working times on October 13, because this is not a true global replace! You will have to manually change that date.)
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Figure 3
15. What is now the completion date? (Check Project Information).  Is it still Friday, November 23?  But why is the total duration of the project now 41.75 days?  The problem here has to do with the recurring task, Project Meeting.  When we originally set up this project, Project meetings were independent of any other tasks and, based upon the original calendar, there were to be eight meetings.  However, if you notice, the final task, Test System, actually completes on November 13.  It looks like we do not need eight project meetings. (How do you find the start and finish dates for each task on your entry table?)

16. Delete the Project Meeting 8 from the task list (but keep the project meetings 1-7).

17. Now what is your completion date and project duration?  It should be November 16, 2007 and 36.25 days.  This gives you an indication that when you change working time, you need to review recurring tasks for their appropriate parameters.  Normally, if we had no recurring tasks, all the changes that we made to the working times would have immediately affected completion dates, but not total hours of work.

Changing a Resource Calendar

Resource calendars track the availability of individual resources.  When you create or assign a resource, the resource is given the base (Standard) calendar by default.  Each resource may be on a different work schedule or have vacations, training or other events, which may interfere with the availability of that resource during the course of a project.  For example, a student working on a project at school may not be available during 8-5, Monday through Friday, but may be available evenings and weekends.


Note: a resource calendar may also be used for other types of resources to reflect maintenance time, down time, cleaning time, etc.

Resource calendars are edited in the same way base calendars are edited.  Resource calendars are available in the Change Working Time dialog box or on the Working Time Tab in the Resource Information dialog box.

1. On the View menu, click Resource Sheet.

2. Select the Project Manager resource.

3. Scroll down the row, until you find the Base Calendar column.

4. You will notice the calendar, Standard, is assigned to this resource.  If you click on the arrow, a drop-down menu appears where you could assign another base calendar to this resource.  Your other choices are 24 hour and Night Shift.  For now, leave this assignment as Standard.
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5. Scroll back and select the Project Manager.

6. From the Standard Toolbar, click the Resource Information button. [image: image5.png]


 (Or you may double-click on the resource name).
7. The Resource Information dialog box should now open.

8. Click the Working Time tab.

9. Click on Monday, October 8, 2007.

10. Let's say the Project Manager will be working on this date, not only in the morning from 8 AM to 12 PM (per standard calendar), but will also be working that afternoon from 1 PM to 5 PM.

11. Click on Nondefault working time and change (or verify) the 8 AM to 12 PM and 1 PM to 5 PM. See figure 4.
12. Press OK.
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Figure 4
13. Now select the Financial Officer on the Resource Sheet.

14. Apparently, the Financial Officer will be away on business the week of October 22-26, 2007. 

15. Click the Resource Information button.

16. Click the Working Time tab and select the dates of Monday, October 22 through Friday October 26, 2007.  Select Nonworking Time and click OK.

17. At this point, you will receive a warning (not an error) indicating that the resource is assigned outside the original dates for task 9 Issue RFPs in project Maynard Furniture Company…
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18. What do you think this message is telling you???  Press OK to accept.

19. Change to the Gantt View, Table: Entry.  What happened to task #9, Issue RFPs?  Why is the completion date of the task November 5?  Why is the duration now 12 days rather than 7 days, yet the amount of work remained the same (56 hours)?   It is always important to remember availability of resources can affect the completion of a task or project. (Your project’s duration is now 39 days).

20. The above is fine for individual resources and individual dates or times, but what about a situation like a student working on a project where the standard, 24 hour or night shift calendars do not apply?

Creating a New Base Calendar

New base calendars can be created when none of the default calendars apply to your project needs or to a group of resources.  In this lab, we know that all managers do not work standard 8-5 hours, so let's create a calendar called Managers.

1. Making sure that you are in the Gantt Chart View, from the Tools menu, click Change Working Time.  Scroll to October 2007. The dialog box should look as figure 5:
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Figure 5
2. While we have seen this dialog box before, notice in the top left corner is a pull down menu. Click on the down arrow for this menu, and you will see the following:

[image: image9.png]Change Working Time

For:

24 Hours
hight shift
LR Standard (.
3 Project Manager
Hsvstems Manager

Set work

Calondar)





Figure 6
3. Here you could change the working time, not only for the three base calendars, but also for each individual resource.  Again, it is best to create a new base calendar.

4. Click the New… button at the bottom of the Change Working Time dialog box and the following dialog box opens:
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Figure 7
5. Type Managers as the name of our new base calendar.

6. Verify that Make A Copy of Standard Calendar is selected and press OK.
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Figure 8
7. Make sure your calendar reflects October 2007.

8. Now click on the column heading for Monday and drag across the day titles to select all the days Monday through Friday (Figure 9).

[image: image12.png]" - |

B ==




Figure 9
9. Select Nondefault Working Time, select the text in the first From box (8:00 AM) and change it to 6:00 AM.

10. Change the 5:00 PM to 8:00 PM. (See Figure 10).
11. Click OK.
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Figure 10
12. To assign a resource to this new calendar, change to Resource Sheet view.

13. Double click on the name, Systems Manager.  Guess what? The Resource Information Dialog box appears.

14. Select the Working Time tab.  In the right hand corner, you should see a drop-down menu for Base Calendar.  Change the base calendar for this resource to Managers and press OK.
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15. On your own, change the Project Manager to the Managers calendar.  After the change, what hours is the Project Manager working on October 8, 2007?  Why is it still 8-5?

16. Finally, create another calendar based upon the 24-hour calendar.  Call this calendar Contractor and set the Nondefault working hours 6 AM to 10 PM (no breaks) for all days of the week.  
17. Assign this new calendar to the Wiring Contractor.  (Note: when you make this change, the duration of the Install Wiring task is still 3 days, but the finish date has been moved up one day.  Why would the duration still be 3 days, when the start and finish date shows only two days?)

18. Your project should now be at 38 days, with a finish date of November 19, 2007.  If not, check to make sure that the Manager’s calendar and the Contractor calendar reflect the correct working times.

Check your work with the provided project information statistics below. If all is right with the world, save your file without a baseline and print out the following reports:  (use proper header information and format)

1. Project Summary Report.

2. Gantt Chart view that includes the following columns: task name, duration, start and finish dates and Gantt chart.

3. Who Does What When report (Under Assignments). (Note: This is different than the Who Does What report).

4. Click on view then select Reports.  Select Workload and then single click on Task Usage report and press Edit. 

5. Under the Definition tab, select Days for column one.  Then press OK.  (We have now edited this report to show each task's information by days rather than weeks.  Please note that once you edit a report, it will retain those settings on the report until you change it!).

6. Press Select and view BUT DO NOT PRINT this report yet– it is 7-14 pages long – wow!!

7. Change the setting back to weeks and THEN print the Task Usage report. 

Check Point for End of Lab 5
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Review Questions

Name              Brian Harman
Answer the following questions using complete sentences (you may use MS Project Help):

1) What are the three base calendars included in MS Project and what are the default values of each?  


24 Hour, Standard, Night Shift are the three calendars that come pre-set-up by MS Project.





2) What is the difference between a base calendar and a resource calendar?



Resource Calendars apply to only specific resources.




3) Should you schedule one more project meeting after completion of the last task, Test System? Why?



We should - as a final meeting to discuss how the project went as a whole.




4) Give an example of when you would assign a 24-hour calendar to a resource.


24-Hour calendars would be used in situations where a consultant is being used to complete a fixed-cost task





5) If you were doing a senior project, what would be the base calendar you would use for students working on the project and what adjustments would you make to it?



The base calendar I would use would probably be the 24-hour calendar because there would not be a set time each task will be worked on.




Attach your four printouts, in print order, to the back of this sheet and submit by the lesson due date.
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